Quick Start Guide
PowerQuest® Drive Image® 2002
Quick Start Guide

Manual Edition 1—April 2002
© 2002 PowerQuest Corporation

All rights reserved. This product and/or its use may be covered by one or more of the following patents: 5,675,769; 5,706,472; 5,930,831; 6,088,778; 6,108,697; 6,108,759; 6,173,291; 6,178,487; 6,178,503; 6,185,575; 6,185,666; and 6,253,300. Additional patents may be pending. Please refer to www.powerquest.com/legal_notices for additional information about PowerQuest’s patents.

The entire risk of the use or the result of the use of this software and documentation remains with the user. No part of this documentation may be reproduced in any means, electronic or mechanical, for any purpose, except as expressed in the Software License Agreement.

This software and documentation are copyrighted. All other rights, including ownership of the software, are reserved to PowerQuest Corporation. PowerQuest, Drive Image, PartitionMagic, and the PowerQuest mark are registered trademarks of PowerQuest Corporation in the United States and elsewhere. DOS, Microsoft, Windows, and Windows NT are trademarks or registered trademarks of Microsoft Corporation. All other brand and product names are trademarks or registered trademarks of the respective owners.

PowerQuest Documentation Feedback

To give suggestions for improving the PowerQuest Drive Image 2002 documentation (quick start guide, online help, or readme files), e-mail your comments to documentation@powerquest.com, or fax them to (801) 437-4480. Specific suggestions are more helpful than general comments. Please include the PowerQuest product name and version with your correspondence. You should not expect technical support assistance from this forum.

PowerQuest Corporation
P.O. Box 1911 • Orem, Utah 84059-1911 • U.S.A.
PowerQuest® End User License Agreement

IMPORTANT: Read this before using your copy of PowerQuest software.

This document is a legal agreement between you (an individual or business) and PowerQuest Corporation (PowerQuest). Use of the software indicates your acceptance of these terms. As used in this License Agreement, the term "Software" means the software included on the CD or disk media provided with this License Agreement. The term "Software" does not include any software that is covered by a separate license offered or granted by a person other than PowerQuest.

IF YOU DO NOT AGREE TO THESE TERMS AND CONDITIONS, EITHER DESTROY OR RETURN, INTACT, THE SOFTWARE PACKAGE, CONTAINING THE CD OR DISK MEDIA, TOGETHER WITH THE OTHER COMPONENTS OF THE PRODUCT TO THE PLACE OF PURCHASE FOR A REFUND OF THE PURCHASE PRICE.

1. PROPRIETARY RIGHTS. The Software and any accompanying documentation are the proprietary products of PowerQuest or its licensors and are protected under national laws and international treaty provisions. Ownership of the Software and all copies, modifications, translations, and merged portions thereof shall at all times remain with PowerQuest or its licensors.

2. GRANT OF LICENSE. The Software and accompanying documentation are being licensed to you, which means you have the right to use the Software only in accordance with this License Agreement. The Software is considered in use on a computer when it is loaded into temporary memory or installed into permanent memory. This License may not be assigned or otherwise transferred without prior written consent from PowerQuest, and any unauthorized transfer is null and void.

You are authorized to use ONLY a single copy of the Software on the number of computers for which you have purchased a license (as indicated on the accompanying license certificate, if applicable). Each permitted copy of the Software may be used only in connection with a single computer owned or leased by you. If the Software is made available on a network, it may be accessed only by ONE specific computer. Once the Software has been accessed by ONE specific computer it may not be used on any additional computers without purchasing additional licenses. All copies of the Software must include the copyright, trademark, and patent notices.

This license is personal to you. You may not sublicense, lease, sell, or otherwise transfer the Software or any of the accompanying documentation to any other person. You may use the Software only for your own personal use if you are an individual, or for your own internal business purposes if you are a business. If you are a service bureau, integrator, value added reseller, or other type of service provider and wish to use this software on your clients' computers, you must purchase a Configuration License.

BACKUP COPY. In addition to any copies authorized under this license agreement, you may make a single copy of the Software solely for backup purposes.

UPDATES AND SUPPORT. You are entitled to receive technical support as outlined in the Software documentation. You are entitled to receive Software updates (updates shall include any patches or bug fixes that PowerQuest makes generally available at www.powerquest.com) in accordance with PowerQuest policies as announced from time to time on terms comparable to those offered to other users of the Software under similar licenses.

TERM. This license is effective from your date of purchase and shall remain in force until terminated. You may terminate the license and this License Agreement at any time by destroying the Software and the accompanying documentation, together with all copies in any form.

3. NONPERMITTED USES. Without the express prior written permission of PowerQuest, you may not (a) use, copy, modify, alter or transfer, electronically or otherwise, the Software or documentation except as expressly permitted in this License Agreement, or (b) translate, reverse program, disassemble, decompile, or otherwise reverse engineer the Software.

4. EXPORT CONTROLS. Certain uses of the Software by you may be subject to restrictions under U.S. regulations relating to exports and ultimate end uses of computer software. You agree to fully comply with all applicable U.S. laws and regulations, including but not limited to the Export Administration Act of 1979 as amended from time to time and any regulations promulgated thereunder.

5. U.S. GOVERNMENT RESTRICTED RIGHTS. If you are acquiring the Software on behalf of any unit or agency of the United States Government, the following provision applies: It is acknowledged that the Software and the documentation were developed at private expense and that no part is in the public domain and that the Software and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph
(c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable. Contractor/Manufacturer is PowerQuest Corporation, P.O. Box 1911, Orem, UT 84059-1911, U.S.A.

6. LIMITED WARRANTY. (a) PowerQuest warrants to you, the original end user, (i) that the Software, other than third-party software, will perform substantially in accordance with the accompanying documentation and (ii) that the Software is properly recorded on the disk media. This Limited Warranty extends for ninety (90) days from the date of purchase. PowerQuest does not warrant any third-party software that is provided with the Software, but PowerQuest agrees to pass on to you any warranties of the owner or licensor to the extent permitted by the owner or licensor. (b) This Limited Warranty does not apply to any Software that has been altered, damaged, abused, mis-applied, or used other than in accordance with this license and any instructions included on the Software and the accompanying documentation. (c) PowerQuest's entire liability and your exclusive remedy under this Limited Warranty shall be the repair or replacement of any Software that fails to conform to this Limited Warranty or, at PowerQuest's option, return of the price paid for the Software. PowerQuest shall have no liability under this Limited Warranty unless the Software is returned to PowerQuest or its authorized representative, with a copy of your receipt, within the warranty period. Any replacement Software will be warranted for the remainder of the original warranty period or 30 days, whichever is longer. (d) THIS WARRANTY IS IN LIEU OF AND EXCLUDES ALL OTHER WARRANTIES NOT EXPRESSLY SET FORTH HEREIN, WHETHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NON-INFRINGEMENT, OR WARRANTIES ARISING FROM USAGE OF TRADE OR COURSE OF DEALING. (e) THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS; YOU MAY HAVE OTHERS WHICH VARY FROM STATE TO STATE. (f) Your failure to return the enclosed registration card or complete the electronic registration included with the Software may result in PowerQuest's inability to provide you with updates to the Software, and you assume the entire risk of performance and result in such an event.

7. LIMITATION OF LIABILITY. IN NO EVENT SHALL POWERQUEST’S LIABILITY RELATED TO ANY OF THE SOFTWARE EXCEED THE LICENSE FEES ACTUALLY PAID BY YOU FOR THE SOFTWARE, EXCEPT FOR A RETURN OF THE PURCHASE PRICE UNDER THE CIRCUMSTANCES PROVIDED UNDER THE LIMITED WARRANTY. NEITHER POWERQUEST NOR ITS SUPPLIERS SHALL IN ANY EVENT BE LIABLE FOR ANY DAMAGES WHATSOEVER ARISING OUT OF OR RELATED TO THE USE OF OR INABILITY TO USE THE SOFTWARE, INCLUDING BUT NOT LIMITED TO DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, AND DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR OTHER PECUNIARY LOSS, EVEN IF POWERQUEST CORPORATION HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, WHETHER SUCH LIABILITY IS BASED ON CONTRACT, TORT, WARRANTY, OR ANY OTHER LEGAL OR EQUITABLE GROUNDS. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

8. NO WAIVER. Any failure by either party to this agreement to enforce a specific part of the agreement in a specific situation is not a waiver of rights under the agreement. The party may still enforce the rest of the agreement in that situation and may still enforce some or all of the agreement in other situations.

9. This License Agreement constitutes the entire agreement between you and PowerQuest pertaining to its subject matter. This License Agreement is governed by the laws of the State of Utah. Any litigation arising from this license will be pursued only in the state or federal courts located in the State of Utah. Even if part of the agreement is held invalid, the rest of the agreement is still valid, binding and enforceable.

Should you have any questions concerning this Agreement, or if you desire to contact PowerQuest Corporation for any reason, please write: PowerQuest Corporation, P.O. Box 1911, Orem, UT 84059-1911, U.S.A.

© 1994-2002 PowerQuest Corporation. All rights reserved. The Software may be protected by U.S. patents, with other patents pending in the U.S.A. and elsewhere. PowerQuest is a registered trademark of PowerQuest Corporation.
# Table of Contents

Glossary ................................................................. vi
Introduction ............................................................. 1
System Requirements .................................................. 2
  Images and CD-R or CD-R/W Media ................................. 2
Installing Drive Image .................................................. 2
  Creating Rescue Diskettes ........................................... 3
Before Running Drive Image 2002 .................................... 3
Running Drive Image the First Time .................................. 4
  Initial Backup Wizard ................................................ 4
  Setup Wizard .......................................................... 5
Creating Backup Images ................................................ 5
Scheduling Backups ..................................................... 8
Restoring Backup Images .............................................. 9
Copying Drives .......................................................... 12
  Using the Copy Drives Feature ...................................... 12
Disk Operations .......................................................... 14
Using Boot Disk Builder ............................................... 15
Using ImageExplorer ................................................... 18
Running Drive Image from the Rescue Diskettes .................... 20
  Rescue Diskette Consideration ..................................... 21
  Creating Images .................................................... 21
  Restoring Images ................................................... 22
  Disk to Disk .......................................................... 24
PowerQuest Technical Support ....................................... 24
  Complimentary Technical Support .................................. 24
  Fee-Based Support .................................................. 25
  Fee-Based After-Hours Support .................................... 25
**Glossary**

**backup location**
Area where an image is saved. Drive Image can save images to a partition on the hard disk, a network directory, or external media such as a CD.

**boot mode**
You enter settings from Windows. When necessary, Drive Image drops to DOS boot mode to perform operations, namely for creating images of the system partition or partitions with open files. After the operation is complete, Drive Image boots back into Windows.

**create**
The process of saving the files that make up the operating system, applications, and data on a hard disk into an image, which can be compressed and stored in a separate location for backup.

**drive**
A partition on your hard disk or on a network that has been assigned a drive letter, such as C:. Compare to hard disk.

**hard disk**
Physical hardware attached to your computer for storing the operating system, applications, and data. Compare to drive.

**image**
A file that includes all the data (including the operating system, applications, and user data) selected for backup.

**partition**
An area of the hard disk that the operating system can format with a file system. Most hard disks include one partition, which is assigned the drive letter C:. The partition that includes the operating system is the system partition. You can create multiple partitions on a hard disk to divide it. Partitions can be visible or hidden. Visible partitions are assigned drive letters; hidden partitions are not.

**restore**
The process of converting an image into files that make up the operating system, applications, and data on a hard disk.
Introduction

PowerQuest® Drive Image® 2002 is a disaster recovery and backup solution. Wizards guide you through creating an exact copy, or *image*, of your hard disk. The image includes the operating system, applications, and data from your hard disk.

You can use wizards or the Disk Operations feature within Drive Image 2002 to create a new backup location to store images on your hard disk.

In addition to saving images on your hard disk (as shown above), Drive Image can save images to a network directory or external media, such as a CD.

If you want to return your system to the state it was in when you created the image, you can *restore* a backup image.

Drive Image includes Boot Disk Builder, which enables you to access network drives from within Drive Image when creating or restoring images that include the *system partition*. (The system partition, usually C:, includes the operating system.) If you are not saving images to a network drive, you do not need to run Boot Disk Builder.

ImageExplorer, also included with Drive Image, lets you manipulate images and restore individual files from within an image. If, for example, you deleted a single data file by accident but had a backup image that included that file, you could use ImageExplorer to restore the file from within your backup image, without restoring the whole backup image.

If you want to move the contents of a hard disk quickly without creating an image, you can *copy drives*. 
System Requirements

Drive Image 2002 requires a Pentium-compatible processor or higher, 20 MB of hard disk space, a CD drive (any speed), and a high-density floppy disk drive. RAM requirements are dependent on the operating system, as noted below.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>RAM Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP Professional or Windows XP Home</td>
<td>128 MB</td>
</tr>
<tr>
<td>Windows 2000 Professional</td>
<td>64 MB</td>
</tr>
<tr>
<td>Windows Me</td>
<td>32 MB</td>
</tr>
<tr>
<td>Windows NT Workstation 4.0 (SP 6a+)</td>
<td>32 MB</td>
</tr>
<tr>
<td>Windows 9x</td>
<td>32 MB</td>
</tr>
</tbody>
</table>

**IMPORTANT!** Drive Image is not supported for use with servers.

Drive Image 2002 displays best at 800 x 600 resolution.

Images and CD-R or CD-R/W Media

If your system meets the following requirements, you can create and restore images from CD-R and CD-R/W media directly from Drive Image (without separate CD burning software):

- You must have an IDE, SCSI, or SCSI PCMCIA CD-R or CD-R/W drive. USB and FireWire CD-R drives are not supported. (The drive must be MMC2-compliant.)

- **Do not** load EMM386.EXE in your CONFIG.SYS file.

- If you create an image on CD-R/W media, the media must be empty and unformatted. CD-R/W media cannot be formatted for DirectCD or for packet writing.

Installing Drive Image

1. Insert the Drive Image CD into your CD drive.

2. If CD auto-run is enabled, the installation program automatically launches when you place the Drive Image CD in your CD drive. If the CD auto-run is not enabled, insert the CD, click **Start > Run**, then type `drive:\AUTORUN` (where `drive` is the drive letter of your CD-ROM drive), then click **OK**.
• **Install**—Install Drive Image, including Boot Disk Builder and ImageExplorer, to a local hard disk.

• **Create Rescue Diskettes**—Create a set of diskettes including a bootable floppy and a program disk that enable you to run Drive Image from DOS.

• **Documentation**—Display PDF manuals for Drive Image or Drive Image error messages. You can use Adobe Acrobat to view and search PDF manuals.

• **Select Language**—Select the language for the Drive Image software you want to install.

• **Exit**—Exit the installation program.

Dynamic disks (disks you can create with the Windows 2000 or Windows XP Disk Management tool) are not supported. You cannot install Drive Image on a dynamic disk or create a backup image of a dynamic disk.

Drive Image 2002 will not overwrite previous versions of Drive Image that you have installed on your machine unless you install to the same location.

### Creating Rescue Diskettes

PowerQuest recommends that you create rescue diskettes at the end of the Drive Image installation. If you do not create rescue disks during the product installation, you can create them later by running the installation program from the Drive Image CD.

If your hard disk becomes unbootable or you do not have access to Windows, you can boot your computer and run Drive Image from the rescue diskettes. The first is a DOS boot diskette. The second includes a DOS version of the Drive Image program. For information about running Drive Image from the rescue diskettes, see “Running Drive Image from the Rescue Diskettes” on page 20 or the online help within the Drive Image DOS program.

### Before Running Drive Image 2002

• Use a disk utility program such as ScanDisk (thorough scan) or Norton’s Disk Doctor to identify and repair any errors on your hard disk. Windows NT Workstation, Windows 2000, and Windows XP users should run CHKDSK /F.

• Create Drive Image rescue diskettes.
• Disable virus detection in the BIOS before creating an image. You should also turn off any low-level disk utilities, such as incremental backup software (for example, GoBack®). If virus protection is enabled, Drive Image may hang or the BIOS may report erroneous viruses.

• Removable drives (Jaz, Zip, etc.) must be set up as removable devices in the BIOS, or Drive Image will not recognize them as removable media and will not enable the media spanning feature. See “Setting Up Removable Storage Devices” in the online help for further information.

• *(Optional)* Run a disk defragmenting utility to further optimize your hard drive.

• Make sure no viruses are on your system.

• Close all other applications.

**Running Drive Image the First Time**

The first time you run Drive Image, you are given an option to run two wizards.

*Initial Backup Wizard*

When you create a backup partition on your hard disk, Drive Image resizes one or more drives on your hard disk to make room for it. The initial backup wizard helps you create an initial image of your hard disk to a CD-R or CD-R/W.

If you do not have a CD-R or CD-R/W drive, you should not use the initial backup wizard.
**Setup Wizard**

Drive Image images must be saved in a partition that is not included in the image. For example, if you are saving everything from your C: drive in an image, you must save the image to a partition other than the C: drive. If you only have a C: drive on your computer, that means you only have one partition on the hard disk.

The setup wizard walks you through the process of creating or selecting a backup partition to save your images. If you do not have a local drive where you can save images, Drive Image will create one for you by creating a new partition on your hard disk.

![Setup Wizard](image)

Typical hard disk with one partition (the C: drive)

Hard disk with an additional partition where a backup image could be saved

---

**Creating Backup Images**

Drive Image creates an exact copy of your hard disk, including operating system, applications, and data. All of this information is saved in a single file called an *image*.

If you have questions that are not addressed in this quick start guide, click **Help** to display more comprehensive information.

1. Close all applications except Drive Image.

2. At the Drive Image main screen, click **Create Image**.
If you have created an image previously, the overview screen displays the settings that you used for the previous image. If you have not created an image previously, the settings are shown as below.

![Image creation interface](image.png)

3 If you want to create an image with the settings you chose previously, go to step 6. Otherwise, click **Select Drives** to select the drives that you want to include in the image. Click the checkbox to the left of the drives you want to back up.

The example below shows a system with two hard disks. If you have one hard disk, the screen displays only one disk.
4 Click **Select Destination** to choose where the image will be saved.

5 Click a drive in the **Select location for image file** box, or click **Browse** to select a filename and location for the image.
6 (Optional) Click **Options** to select the compression level for the image, add a password to the image, split the image into multiple files, check for file system errors before creating the image, verify disk writes when creating the image, or verify image contents after creating the image.

For details about these options, click **Help** from the Options screen.

7 (Optional) Click **Schedule** to set a time for the image to be created. See “Scheduling Backups” on page 8.

8 Click **Finish**.

9 If you are creating an image of the drive that includes your operating system or a drive that includes open files, click **Yes** to reboot the machine so Drive Image can create the image in boot mode.

If you save an image to removable media, Drive Image will automatically span it across media as needed. The first segment of the image will have a PQI extension. Subsequent segments will be named with .001, .002, and so forth. For example, if your image spans two CDs, it might be named MyBackup.pqi and MyBackup.001.

### Scheduling Backups

After you have specified the drives you want to include in the image and where you want the image to be saved, you can either create the image immediately or schedule the image to be created later.

**IMPORTANT!** The Schedule feature in Drive Image is dependent upon the Windows Task Scheduler feature. If you did not install Task Scheduler when you installed Windows, you cannot schedule image creation.

1 At the Create Image screen, click **Schedule**.

2 Type a name for the task, then click **Add**.

3 In the **Add Schedule** dialog, click **New**.

4 If you want to create more than one backup schedule, make sure **Show multiple schedules** is selected on the Schedule tab.

   To create only one backup schedule, deselect **Show multiple schedules**, then continue with step 6.

5 Select the frequency of the back up from the **Schedule Task** drop-down list.
6 Click OK.

7 Click the Settings tab and Drive Image tab to review and specify the settings.

For details about the options on the Settings and Drive Image tabs, see the Drive Image online help.

8 Click OK.

The scheduled task will now appear in the Windows Scheduled Tasks folder.

**Restoring Backup Images**

If your computer is not performing well, you can restore a backup image to return the computer to the state it was in when you created the backup image. Any changes you made on your computer after creating the backup image (such as installing applications or saving data files) are lost when you restore the image.

1 From the Drive Image main screen, click **Restore Image**.

The currently selected settings appear on the Overview screen.
2 Click **Select Image File**.

3 Select an image from the list, or click **Browse** to find the image. You can right-click to add and remove images from the list.

4 Click the checkboxes for the partitions you want to restore.

5 Click **Select Destination** and click the partition or unallocated space where you want the image to be restored. If you select a partition, it will be deleted before the image is restored.
6  *(Optional)* Click the **Restore to original locations** checkbox if you want to restore the partitions to the location they were created from.

If you created the image with an earlier version of Drive Image, you cannot select **Restore to original locations** using the checkbox, but you can still restore the partitions within the image to their original locations by choosing those locations.

7  *(Optional)* To free up space for restoring partitions, click the checkbox for a partition, then click **Delete Partition**. This operation can be undone by clicking **Undo Delete**.

8  *(Optional)* Click **Options** to change settings that affect how the image is restored, whether drives are hidden after they are restored, and whether drives should be restored as primary/logical drives or just logical drives. Click **Help** at the Options screen to display information about these settings.

9  Click **Finish**.

10  If your machine is set to boot from the CD drive first, remove the CD from the drive after you click Finish.

When Drive Image is ready to pull the image from the CD, you will be prompted to reinsert it. If you do not remove the CD, Drive Image DOS will boot from the CD, prompting you to choose the image and destination again. (If your computer is not set to boot from the CD drive first, this step is unnecessary.)
After restoring an image from a CD, remove the CD from the drive.

**Copying Drives**

You can use the Copy Drives feature when you want to copy your hard disk without making an image. Copying drives is useful when you are upgrading to a new hard disk. The Copy Drives feature makes an exact copy of a drive or an entire hard disk and makes use of any additional space available on the new hard disk.

Much of the work involved with upgrading a hard disk is work not connected to the Drive Image software. For example, you must open the case of your computer, install the new hard disk, change jumper settings to recognize the new hard disk, and so forth. For an overview of the entire process (in English only), see CopyDrives.pdf in the /English/Docs folder on the Drive Image CD, or go to the PowerQuest Technical Support web site at www.powerquest.com/support and find the document under Desktop Solutions.

**Using the Copy Drives Feature**

1. From the Drive Image main screen, click **Copy Drives**. Because you have not chosen any settings, the Overview screen (below) will display prompts rather than settings you have chosen. You can click **Overview** at any time during the process to review the current settings.
2 Click **Select Drives** to choose the drives you want to copy. Click the checkbox of the drives you want to copy.

3 Click **Select Destination**, and choose the new hard disk. It will show up as unallocated space (space not assigned to a partition on the hard disk).
If you select an existing drive instead of unallocated space, the data on that drive will be overwritten with the data from the drives you are copying.

4 (Optional) Click Options to specify how drives on both the old and new hard disk will be treated after the copy is complete.

5 Click Finish.

Drive Image may boot your computer into DOS to copy the disk.

**Disk Operations**

You can use Disk Operations to do the following:

- Create a backup partition.
- Remove a backup partition.
- Redistribute free space among partitions.
- Hide/unhide partitions.
- Set a partition as active (the one the computer boots from).
1 From the Drive Image main screen, click **Disk Operations**.

2 Click a button to launch a wizard or choose an option from the menu bar.

For complete information about disk operations, click **Help > Contents** from the Drive Image menu, or click **Help** from the screen you have questions about.

### Using Boot Disk Builder

PowerQuest Boot Disk Builder is a Windows application that automates and simplifies the creation of DOS boot disks. You need to use Boot Disk Builder only if you want to save or restore images from a network directory. It is available from the Drive Image main screen.

Before you start, note that to add a new network driver, you will need the .INF file for the driver and an .EXE or .DOS file for Microsoft.

1 Click **Boot Disk Builder** at the Drive Image main screen, or click **Start > Programs > PowerQuest Drive Image 2002 > Boot Disk Builder**. Click Next.
2 Enter the Microsoft TCP/IP settings, then click **Next**.

3 Select your network adapter or multiple adapters, then click **Next**.

If your network adapter is not listed, add it to the list of network adapters.

   **a.** Click **Add**.

   **b.** Specify the location of the driver file (*.INF) for your network adapter. You can click the browse button to browse the directory tree for the driver file.
c. Choose one or more adapters from the list, then click **Next**.
d. Select the Microsoft TCP/IP drivers.
e. Click **Finish**.

4 Select the network adapter you are using from the list box, then click **Next**.

5 Select the type of boot disk to build.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Floppy Disk  | If you are creating a DOS boot disk, select **Floppy Disk** and choose the drive letter where your floppy disk is located.  

Boot Disk Builder can only write to formatted disks. Any existing information on the disk will be lost.

The network and Drive Image files may require two disks. You will be prompted if a second disk is needed. |
Quick Start Guide

18

Click **Back** to make any changes, or click **Finish** to build the boot disk.

**Using ImageExplorer**

You can start PowerQuest ImageExplorer from the Drive Image main screen to do the following:

- Restore individual partitions or specific files from within images
- Copy partitions from within images
- Compress and uncompress partitions within images
- Modify password settings on images
- Split a large image into multiple files

The ImageExplorer main screen is divided into three panes: Locate, Recent, and Contents.

<table>
<thead>
<tr>
<th>Screen area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locate pane</td>
<td>Displays a tree view of all the drives on your machine (local hard disks, CD drives, and network drives).</td>
</tr>
<tr>
<td>Recent pane</td>
<td>Displays a tree view of images you have browsed to or opened recently. You can clear the list of recent images by clicking Recent &gt; Clear Recent Images List.</td>
</tr>
<tr>
<td>Contents</td>
<td>Displays the contents of the selected drive, folder, image, or partition.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Provides quick access to common tasks. You can display or hide the toolbar using the View menu. You can also use the View menu to determine whether to display text labels on the toolbar buttons.</td>
</tr>
<tr>
<td>Status bar</td>
<td>Displays a brief description of the toolbar button where the pointer is located. You can display or hide the status bar using the View menu.</td>
</tr>
</tbody>
</table>
To open an image, browse for the file in the Locate or Recent pane on the left side of the main screen in ImageExplorer. When you select an image, the partitions in the image display in Contents pane on the right side of the window. You can expand the view of an image in the Recent or Locate pane to display its partitions in that pane. You can also expand the partitions to display individual folders within the partitions. When you click a folder in the Locate or Recent pane, the individual files within that folder display in the Contents pane.

You can copy, compress, split, or add a password to an image or partition by right-clicking it and choosing **Copy to Image**. In the **Copy to Image** dialog, you enter a filename and path for a new image and specify the settings you want. ImageExplorer copies the image or partition to a new image.

You can restore individual folders or files by right-clicking them and choosing **Restore**.

ImageExplorer cannot view images found on hidden partitions. To unhide a partition, use Disk Operations from Drive Image. See “Disk Operations” on page 14.

For detailed information about ImageExplorer, open ImageExplorer and click **Help > Contents** to display the online help.

**Running Drive Image from the Rescue Diskettes**

You will normally run the Windows version of Drive Image. If your computer will not boot, you can run the rescue diskette version of Drive Image. The DOS interface is different from the Windows interface, but the underlying features are the same as the Create Image and Restore Image features of the Windows product.

You can run Drive Image using a network boot disk that you created with Boot Disk Builder or with the default boot disk that is created by the Drive Image installation program.
The Disk to Disk feature in the rescue diskette version of Drive Image is a DOS equivalent of the Copy Drives feature in the Windows version of Drive Image.

**Rescue Diskette Consideration**

On Windows 95, Windows 98, and Windows Me systems, Drive Image uses the operating system’s DOS files to build the first rescue diskette. On Windows NT/2000/XP systems, Drive Image uses Caldera DOS.

When you boot from a rescue diskette with Caldera DOS, some drives (partitions) may not display with drive letters. Instead, they will use the following naming convention: `\diskm.partn`. For example, the second partition on the first hard disk would display as `\disk1.part2`. The volume label (if there is one) will also display to help you identify the drive. You can still include these drives in images or save images to drives with the unconventional designation.

If you use a Windows 95/98 startup disk in place of the Drive Image bootable diskette (diskette 1 of the 2-diskette set), drive letters will display for all your drives, except hidden, NTFS, and Linux partitions.

Drive letters do not display for CD drives from the rescue diskette version. Instead, they display as `\\.\pqcdx`, where `x` is the number of the CD drive.

**Creating Images**

You can create an image from the rescue diskette version of Drive Image. At any screen, you can click Help to display more detailed information than is included in this quick start guide.

1. Click Create Image at the main screen.
2 If you have more than one hard disk, select the disk you want to back up.

3 If there is more than one drive (partition) on the disk, select the drives that you want to back up.

4 Specify a path and filename for the image. It is wise to click Browse to choose the path for the image, since drive letter assignments are likely different from their designations when you run Drive Image under Windows. When you click Browse, you can choose the drive from the Drives drop-down list in the New Image File dialog.

5 Choose a compression level for the image.

6 (Optional) Click Advanced Options to change image settings, split an image, or add a password.

   Click Help in the Advanced Options dialog for details.

7 Click Finish.

Restoring Images

You can restore an image from the rescue diskette version of Drive Image. At any screen, you can click Help to display more detailed information than is included in this quick start guide.

1 Click Restore Image at the main screen.
2 Select the image to restore, then click **Next**. You may want to click **Browse** to identify the drive where the image is located, since drive letter designations are likely to be different from running under Windows.

3 If you have more than one hard disk, select the destination drive, then click **Next**. (The screen does not appear if you only have one hard disk.)

4 Select the space where you want to restore the image, then click **Next**. This space may be an existing partition or unallocated space.

5 Select the disk write mode, then click **Next**.

6 *(Optional)* Click **Advanced Options** to change settings that affect the restore process.
7 Click Finish.

**Disk to Disk**

The Disk to Disk feature in the rescue diskette version of Drive Image is the same as the Copy Disk feature in the Windows version. Follow the instructions under “Copying Drives” on page 12, except run the rescue diskette version of Drive Image instead of clicking **Copy Drives** in the Windows version of Drive Image.

**PowerQuest Technical Support**

PowerQuest offers a variety of technical support solutions. You can choose the level of technical support that best fits your needs.

When you encounter a problem, you can often find solutions by consulting the product’s online help, the quick start guide, the README file, or PowerQuest’s technical support web site (www.powerquest.com/support) or by applying the most recent patch or upgrade of the software (www.powerquest.com/updates).

You must furnish your product license (serial) number when you contact PowerQuest for technical support.

To better assist you in resolving problems, PowerQuest technical support engineers may request information from the PARTINFO utility program. See “Generating Diagnostic Reports with PARTINFO” in the product online help.

Technical support for PowerQuest products is available beginning with the release of the product and ending six months after the release of the next major version of the product or after PowerQuest discontinues the product line.

**Complimentary Technical Support**

PowerQuest’s complimentary technical support consists of self-help support tools that are available at www.powerquest.com/support (in English only).

- An easy-to-use, powerful knowledge base that helps you find answers to the most frequently asked product questions, as well as “how-to” procedures and technical information about all PowerQuest products.
- Dozens of easy-to-use video clips that step you through product features.
- Product updates and patches for the most recent versions of PowerQuest products.
• An automated e-mail form you can fill out to request written assistance from a PowerQuest technician. (Requests for e-mail support in North America are processed 8:00 am to 5:00 pm MST, Monday through Friday.) To obtain e-mail technical support for specific technical questions, fill out the form at the web site specified below.

<table>
<thead>
<tr>
<th>Language</th>
<th>Location of E-mail Support Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td><a href="http://www.powerquest.com/support/emsupport.cfm">www.powerquest.com/support/emsupport.cfm</a></td>
</tr>
<tr>
<td>French</td>
<td><a href="http://www.powerquest.com/support/emsupport.cfm?language=FR">www.powerquest.com/support/emsupport.cfm?language=FR</a></td>
</tr>
<tr>
<td>German</td>
<td><a href="http://www.powerquest.com/support/emsupport.cfm?language=DE">www.powerquest.com/support/emsupport.cfm?language=DE</a></td>
</tr>
</tbody>
</table>

**Fee-Based Support**

PowerQuest’s fee-based technical support program consists of live telephone support during regular business hours (8:00 a.m. to 5:00 p.m. MST, Monday through Friday).

Step-by-step consultations on product features and functionality fall under the fee-based support program.

<table>
<thead>
<tr>
<th>Language</th>
<th>Location</th>
<th>Telephone Number and Fee</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>U.S.A.</td>
<td>800-757-5049 at $30.00 USD per incident, charged to a credit card</td>
</tr>
<tr>
<td></td>
<td></td>
<td>900-328-8324 at $2.95 USD per minute, charged to your phone bill (first two minutes are free)</td>
</tr>
<tr>
<td>English</td>
<td>U.K.</td>
<td>+44 (0)20 7341 5517 at $30.00 USD or €34.50 (Euros) per incident, charged to a credit card</td>
</tr>
<tr>
<td>French</td>
<td>France</td>
<td>+33 (0)1 69 32 49 30 at $30.00 USD or €34.50 (Euros) per incident, charged to a credit card</td>
</tr>
<tr>
<td>German</td>
<td>Germany</td>
<td>+49 (0)69 66 568 516 at $30.00 USD or €34.50 (Euros) per incident, charged to a credit card</td>
</tr>
</tbody>
</table>

**Fee-Based After-Hours Support**

PowerQuest offers fee-based after-hours support by telephone only. After-hours support is designed for anyone who requires support outside of regular business hours (8:00 a.m. to 5:00 p.m. MST, Monday through Friday). The price is $95.00 USD per incident.
# Index

## A
- accessing network drives 15

## B
- Boot Disk Builder 15

## C
- CD-R support 2
- copying drives 12
- creating images 5
  - at scheduled times 8
  - on CD-R 2
  - using rescue diskettes 21
- creating partitions 14

## D
- disk operations 14
- Disk to Disk 24
- dynamic disks 3

## F
- files, restoring from within images 18

## H
- hardware requirements 2

## I
- ImageExplorer 18
- images, creating 5, 21
- images, restoring 9, 22
- initial backup wizard 4
- installing Drive Image 2
- introduction 1

## N
- network boot disks, creating 15

## O
- overview, Drive Image 1

## P
- partitions, creating 14
- passwords, adding to images 18
- prerequisites 3

## R
- requirements 2
- rescue diskettes
  - creating 3
  - creating images with 21
  - restoring images using 22
  - running Drive Image from 20
  - special considerations 21
- restoring images 9, 22
- restoring individual files from within images 18
- running Drive Image for the first time 4

## S
- scheduling image creation 8
- setup wizard 5
- software requirements 2
- support, technical 24
- system requirements 2

## T
- technical support 24
- troubleshooting
  - I can’t run Drive Image from Windows 20
  - I can’t save an image to the network 15
  - my CD-R drive isn’t recognized 2

## U
- upgrading hard disks 12

## W
- wizards
  - initial backup 4
  - setup 5